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Descripcion . .
Processing es un contexto para explorar el espacio conceptual emergente que nos entregan

los medios electronicos. Es un entorno para aprender los fundamentos de la programacion
informatica dentro del contexto de las artes electronicas y es un bloc de notas electrénicas
para desarrollar ideas.

WWW.processing.org

El entorno de Processing es el mas facil compilador de Java / entorno de programacion
multimedia y grafico conocido por el hombre. El sistema puede ser usado para producir piezas
que arrancan localmente, como también Applets de java incrustados en la web.
Deliberadamente, el programa esta disefiado para hacer un puente entre la programacion
grafica educacional, y el java "real". Processing puede ser utilizado como rueda de

entrenamiento, pero no tiene por qué ser eso.

El propésito de este manual es introducir a los usuarios de Flash Macromedia y Director al
entorno de Processing a través de la comparacion y el contraste de los sistemas. La teoria dice
que el conocimiento adquirido a través de las herramientas de Macromedia puede ser
facilmente transferido, reduciendo la cantidad de clases necesarias. Se asume que tienes un
conocimiento basico de alguno de los productos de Macromedia. Hacia el final de este manual
deberias ser capaz de producir tus propias piezas de Processing (Java).
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Introduccion

Obtener el

El futuro

Actualmente, en clases interactivas de disefio digital, el vehiculo educativo dominante ha sido
Flash o Director. Los estudiantes estan empezando a realizar trabajos geométricamente
dinamicos y algoritmicamente méas complejos influenciados por trabajos realizados en
entornos diferentes a los suyos. En ITP, atestigiié un experimento en una clase (claro, que
desde entonces estan usando Processing). En medio de la ensefianza de Director Lingo, un
intensivo de una semana a la programacion en Java introduce a los alumnos a un lenguaje
diferente a Lingo - con la esperanza que adquieran una vision mas diversa de distintos
sistemas de programacion. Se les entreg6 una plantilla y ellos simplemente cambiaron el
codigo. Luego de una semana de confusion algunos de los estudiantes quedaron con una
sensacion de vacio, anhelando saber mas de Java. No hubo manera de explicarles que un
curso de Java promedio en una escuela, frecuentemente te tiene trabajando en una consola
de texto y que tiene poco o nada de relacion con grafica de Applets al menos que sea un curso
especificamente enfocado para ensefiar eso. En la leccion siguiente, espero hacer un puente
sobre este hueco académico con la ayuda del entorno de Processing. No esta pensado como
un reemplazo a aquellos cursos de Java sino un suplemento que se preocupa de la logistica,
sin profundizar en los matices sintacticos. Ademas, Processing y Java no son presentados
como el siguiente nivel después de Macromedia, tampoco como un sistema de nivel inferior.
Son simplemente una alternativa capaz de hacer cosas de modo distinto. Si actualmente
asistes a un curso de Java, es posible que uses Processing en tus trabajos, dependiendo de la
flexibilidad de tu profesor. Este manual es una mezcla entre mi redaccién e imagenes y otras
encontradas en el sitio de Processing que mantienen Casey Reas y Ben Fry. Te familiarizaras
con estos nombres en la medida que te hagas usuario de Processing.

software de Processing es libre (libre como la cerveza gratis, libre como la libertad de expresion, libre

Processing

Un paseo por
la interfaz

como un pais libre) y todavia en desarollo. Seguira siendo libre incluso después de ser
terminado. Este software estd actualmente en la fase BETA. Los errores estan siendo
reparados y otros aspectos estan siendo agregados. Para descargarte el programa de
instalacion de multiplataforma, puedes mandar un email a los desarrolladores para unirte a la
comunidad de testeo. En la pagina de Processing, pincha Download para mas instrucciones.
Ademaéas hay un fluido sistema de mensajes entre los testeadores. Es altamente recomendable
que te crees una identificacion de entrada (login) para ti mismo. La comunidad que se ha
creado a su alrededor es la mejor manera de recibir ayuda en cualquier materia, de otros
miembros de la comunidad de testeo, de los mismos autores y de otros empollones
informaticos como el autor de este articulo. Es importante sefialar que esta comunidad en
linea ayuda a desarrollar Processing a través de la discusion de aspectos en los foros. En la
pagina de Processing pincha Discourse. Tanto la pagina de Processing como el software estan
constantemente siendo actualizados. Ve revisando por nuevas actualizaciones y versiones del
software. Justamente ahora es un momento muy emocionante!

La siguiente imagen fue sacada de www.processing.org. Para verla en contexto pincha
Reference y luego Environment.

Text Editor

dora = LE0d)

Dizplay Window

Meszage Area
Text Area
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Manipulacion
de medios a
bajo nivel

Probablemente estas pensando: “Jo, qué simple esta interfaz. ;Cémo puede ser tan potente
como Director o Flash?” Ambos, Director y Flash, poseen todo tipo de interfases de
importacion y edicion de medios, basados en funciones comunes de multimedia comercial. En
Processing todo esto se hace o usando otro programa o programando en Java. Por ejemplo,
Flash tiene su propio mini llustrator, mientras Director viene con su propio mini Photoshop. En
consecuencia, un largo trozo del trabajo realizado en ambos programas ha asemejado las
restricciones de sus editores integrados. En Processing (y en Java), tu provees tu propia lista
de gréficas vectoriales o archivos GIF, y los interpretas usando programacion. Eres libre para
usar tus propias formas y estructuras, usando el lenguaje para controlar los pixeles en la
pantalla mas directamente. Para aquellos que gustan de experimentar y desean producir
nuevas formas de manera independiente o delante del status quo y sus herramientas de
automatizacion, Processing puede ser mas conveniente.

Aqui hay una introduccién de seis botones del costado izquierdo de la ventana.

@ El botén de reproducir (play) es el mismo que en Director y Flash.
Cliquéalo para ver tu codigo ejecutado como un programa.

@ El boton de parar (stop) es el mismo que en Director o Flash. Cliquéalo
para detener tu programa.

Crea un nuevo (new) archivo. Processing los llama sketches (bosquejos).
los puedes llamar también Applets, programas o piezas interactivas.
Director y Flash los llamanmovies ( peliculas).

Abre (open) un sketch preexistente. Un menu aparecera y podras elegir
dentro de tu propia coleccién, guardada en la carpeta especial de
Processing que te ensefaré mas adelante. También puedes elegir dentro de
una amplia gama de ejemplos de sketches realizados por famosos
disefladores/artistas de nuevos medios, para aprender de ellos y usarlos
como coédigo de referencia.

Guarda (save) en sketch actual dentro de la carpeta de sketches de
Processing. Si quieres darle un nombre distinto vete a guardar como (save
as) en el menu de archivo (File).

Exporta (export) el sketch a la carpeta de sketch de Processing, esta vez
como un Applet de java, completo con su propio archivo html. Esta
propiedad sera tratada con mas profundidad mas adelante.

Para mayor y mas detallada informaciéon acerca del entorno de Processing, ver la referencia de
Entorno de Processing.

En Director, uno importa o crea medios dentro de un reparto, luego lo arrastra hacia un
escenario donde existira como un actor. En Flash, uno también importa o crea medios dentro
de una libreria y luego los instancia como clips de peliculas a un escenario similar. En
Processing (y en Java) esta importacion de medias estéa realizada en cédigo, de manera
similar como trabaja HTML. Adicionalmente, cualquier medio personalizado que tu inventas
(sistema de vectores, datos DNA, muestras de colores de una pelicula) todos pueden ser
insertados como parte del cédigo Java. De hecho, no estéas restringido a tener cualquier
imagen externa o sonidos si quieres mantener todo en un archivo ordenado, porque el pixel
de tu imagen también puede convertirse para ser parte de tu cédigo, y los datos de sonidos
también pueden ser almacenados como un largo array de datos. El beneficio de una libreria o
reparto es para tener mayor control sobre el formato, para ahorrar espacio en el disco /
memoria, y también para agregar caracteristicas apuntables&cliqueables hacia un metaférico
sistema de archivo comun. El beneficio del actor o de la pelicula es que un objeto visible y
tangible puede estar en la pantalla y ser una manera facil para que la gente cree botones,
video juegos, caracteres, elementos individuales graficos y otros elementos visuales y
controlables de espacio positivo. De todas maneras, creando grupos de cooperacion de
elementos y objetos que no son ni de espacio negativo ni positivo, esta metafora se ha
convertido en carga para algunos. En Processing, esta complicada capa no existe; hay solo

teclado, ratén y una serie de eventos en conjuncidn con rutinas basicas de dibujo. Uno se
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ocupa de redibujar la escena repetidas veces para introducir cambios y tiempo. En esta
materia, es tu responsabilidad el escribir tu propio sistema de actor o pelicula, pero no te lo
requeriran. Inventa otra metafora que serd mas util para ti como artista. También contribuiras
para diversificar con profundidad la estética de aquellos trabajos en cuales usualmente vemos
la influencia de Macromedia.

En las siguientes secciones de esta guia, introduciré métodos para renderizar la imagineria a
la pantalla. Luego introduciré una animacioén. Finalmente, te mostrare como agregar
animacion con el ratén, teclado y el puerto serial. Estos son los pilares basicos para cualquier
cosa que quieras hacer con las herramientas de mayor nivel. Seras capaz de hacerlos en Java
si te focalizas en construirlos tu mismo.

Estructura Para los que usan Flash MX esto es un repaso. Lo siguente se llama StatementsComments en
sintactica los ejemplos.

// Statements & Comments
// by REAS

// Statements are the elements that make up programs.

// The ";" is used to end statements. It is called the "statement terminator."

// Comments are used for making notes to help people better understand programs.
// A comment begins with two forward slashes (*'//").

// Created 1 September 2002

// The size function is a statement that tells the computer

// how large to make the window.

// Each function statement has zero or more parameters.

// Parameters are data passed into the method

// and used as values for specifying what the computer will do.
size(200, 200);

// The background function is a statement that tells the computer
// which color to make the background of the window

background(102);

Y las variables de Java son como a continuacion:

int x = 0;

printin(x);

X=x+1;

printin(x); Pincha reproducir (play) y
X=x+1; Ves eso:

wWN PO

printin(x);

Personas que usen Flash: No hay nada como var. Para mayor informacién de variables,
consultar la guia oficial de lenguaje Java.
Aqui esta la parte de la variables.

Qué ocurre con if-then?

inta=1;
intb = 2;
if(a==b){ . .
printin("same"); Pincha reprodumr (play) y e
Yelse{ ves eso:

printin("different™);
¥
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Dibujo 2D
estatico

Las cosas son un poco diferentes a Lingo si hay que comparar. El programador usa un s6lo

“=" para asignar a una variable un valor. Uno usa “==" (doble igual) cuando intenta
determinar que si un nimero es igual a otro nimero o no. “No igual a * no es mas “<>",
ahora es “1="y los demas son los mismos ("<", ">", ">=" |y "<="). Para informacién en

condicionales, consulte a la autoridad.

¢Y repetir bucles?

for(int i=0 ; i<5 ; i++){
printin(i); Pincha reproducir (play) y
ves eso:

A WNPEFO

Usuarios de Lingo, esto es los mismos que “repeat with i=0 to 4”. Dentro de estos paréntesis
hay tres declaraciones separadas por dos punto y coma. La primera declaracion crea una
variable temporal. La segunda declaracion especifica la condicién que permite al bucle
continuar su repeticién. A penas i no es mas menor que 5, el bucle se detendra. La tercera
declaracion te dara la posibilidad de incrementar i como desees. “i++" es la abreviacion de “i
= i+1"”. Sun podréa contarte mas acerca de los bucles.

Mientras los bucles son similares a la estructura de un if-then.

while(6!=2){

printin("muhuhaha!"); .
1 No ejecutes este programal

Si estas curioso de saber mas de la sintaxis de control de flujos, aqui hay un link del manual
de lenguaje de Java. La parte de control de flujos.

Me meteré en funciones en un momento. Entrego estas instrucciones basicas de sintaxis no
para ser cuidadoso sino para que comprendas las instrucciones que vienen a continuacioén.

Para una mayor introduccién a las estructuras, mira la Comparacion de Lenguaje Processing y
los Ejemplos de Estructura de Processing.

size(200,100);
background(0,0,0);

stroke(255,0,0); Arrangue este codigo y
point(50,50); obtendras la siguiente
stroke(0,255,0); imagen. Esta es la gran
point(100,50); ventana negra con tres
stroke(0,0,255); pixeles de colores rojo,
point(150,50); verde y azul.

Permitenos descomponer este cédigo linea por linea.

+i
[0,0] . . .
Primero que nada conviene saber que la pantalla es un gréafico de

pixeles, cada uno registrado para una Unica coordenada (X,Y). El
origen (0,0) esta en la esquina izquierda arriba del rectangulo. Al
sumar a Y, te mueves hacia abajo. Al sumar a X, te mueves a la
derecha. Es parecido a jugar el juego de tablero, Combate Naval.
No tiene diferencia a Director o Flash.

+
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size(200,100);

Nombrando la funcién de tamano (size), permite el tamafio del lienzo a 200 pixeles de altura,
100 pixeles de ancho. Si no defines esto al inicio quedara determinado como 100x100.

background(0,0,0);

Llamando la funcién de fondo (background) te permite cambiar el color de todo el lienzo. En
Director esto es el color del escenario. En Flash, esto es el color de fondo del documento.
0,0,0 significa negro. Si nunca llamas negro al fondo, quedara predeterminado como gris.

stroke(255,0,0);

Llamar la funciéon de trazo (stroke) te permite cambiar el color del dibujo actual de tal
manera que cada comando de color llamado luego sera dibujado usando ese color. 255,0,0
significa rojo. Si nunca llamas trazo en Processing, por definicion sera negro.

point(50,50);

Llamar la funciéon de punto (point) fijara el pixel en 50,50 al color del lienzo actual. En este
caso, rojo.

stroke(0,255,0);
point(100,50);

Este codigo hace un punto verde en el centro.

stroke(0,0,255);
point(150,50);

Este cddigo dibuja el punto azul a la derecha.
Como puedes ver, esto es similar a draw() en Lingo, o aquellos métodos de dibujo en

ActionScript. Tu controlas la pantalla como si fuera un lienzo que entiende ciertas operaciones
de dibujos. Permitenos desarrollar formas mas complejas.

Aqui estoy dibujando dos lineas.
La primera blanca y la segunda,

background(0,0,0); amarilla.

stroke(255,255,255);

line(0,0,60,40); En la linea de funciones, los dos
stroke(255,255,0); primeros parametros son las

line(30,50,100,100); primeras coordenadas y los
ultimos dos parametros son las
segundas coordenadas X,y. La
linea se dibuja desde la primera
coordenada a la segunda.

Aqui hay unas formas prefabricadas.

ekch_030 ;IQI il

size(150,100);

quad(61,60, 94,60, 99,83, 81,90);
rect(10,10,60,60);
ellipse(80,10,60,60);
triangle(12,50, 120,15, 125,60);

triangle(triangulo) dibujara un poligono de tres puntas. Tiene seis parametros. Parametros 1
y 2 son los primeras coordenadas X,Y. Parametros 3 y 4 son las segundas coordenadas X,Y.
Los parametros 5 y 6 son las terceras coordenadas X,Y.

triangle(x1, y1, x2, y2, x3, y3);
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quad (cuadrado) dibujara un poligono de 4 puntas. La estructura de los parametros es similar
a las del triangulo, pero esta vez un cuarto par de parametros se agregan para especificar una
cuarta coordenada X,Y.

quad(x1, y1, x2, y2, x3, y3, x4, y4);

rect dibujara un rectangulo. El primer y segundo parametro especificaran la posicion,
mientras que el tercero y el cuarto lo haran con la altura y el ancho.

rect(x, y, width, height);
ellipse dibujara un 6valo. Sus parametros trabajan de la misma manera que los de rect.
ellipse(x, y, width, height);

Ahora modificaré el programa para mostrarte algo nuevo. El nuevo cédigo esta marcado.

0301,

size(150,100);

fill(#CC6600);

stroke (#FFFFFF);

quad(61,60, 94,60, 99,83, 81,90);
rect(10,10,60,60);
ellipse(80,10,60,60);
triangle(12,50, 120,15, 125,60);

(Nota aqui, que estoy especificando colores de una manera diferente que antes -esta vez en
estilo HTML)

Fill (llenar) se introduce como un primo del trazo. Fill es lo que hace que el poligono verde,
mientras que el trazo es lo que hace que los bordes sean rojos. Los parametros de fill
especifican el color, como el trazo. Esta predeterminado como blanco. Pero qué pasa si no
quieres llenar?

etch_0300 e =] 1|

size(150,100);

noFill();

stroke (#FFFFFF);

quad(61,60, 94,60, 99,83, 81,90);
rect(10,10,60,60);
ellipse(80,10,60,60);
triangle(12,50, 120,15, 125,60);

Ahora puedes ver el cuadrado debajo del 6valo porque sélo los trazos han sido dibujados. De
manera similar, existe un noStroke (no trazo), que deshabilita los bordes de ser dibujados .
Para habilitar el trazo o el llenar una vez mas debes llamar el trazo o el llenar especificando un
color.

Dibujar con curvas es ligeramente mas complicado que dibujando con lineas rectas.
Especificando una curva requiere proveer informacion no visual que ayude a definir la
severidad y direccion de la curvatura. Processing provee ambos métodos, curve( ) (curva) y la
curva de bezier( ).

curve(84, 91, 68, 19, 21, 17, 32, 100);
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curve(10, 26, 83, 24, 83, 61, 25, 65);

stroke(255, 102, 0);

line(85, 20, 10, 10);

line(90, 90, 15, 80);

stroke(0, 0, 0);

bezier(85, 20, 10, 10, 90, 90, 15, 80);

stroke(255, 102, 0);

line(30, 20, 80, 5);

line(80, 75, 30, 75);

stroke (0, 0, 0);

bezier(30, 20, 80, 5, 80, 75, 30, 75);

curve(xl, y1, x2, y2, x3, y3, x4, y4);
bezier(x1, y1, x2, y2, x3, y3, x4, y4);

Para la funcién de curve(), el primer y segundo parametro especifica el punto de la curva y
los dos ultimos parametros especifican el segundo punto de la curva. Los parametros de en
medio establecen los puntos para definir la forma de la curva.

Para la funcion bezier( ), los primeros dos parametros especifican el primer punto de la curva
y los dos ultimos parametros especifican el uGltimo punto. Los parametros de en medio otorgan
el contexto para definir la forma de la curva.

En los ejemplos de bezier( ) de arriba, las lineas naranjas revelan los puntos de control
escondidos de las curvas.

A pesar que Processing otorga estos primitivos rapidos, eres libre para construir tus propias
formas.

Usando los métodos de beginShape( ) y el endShape( ) son la llave para crear formas mas
complicadas. beginShape( ) empieza registrando vértices para una forma y endShape( )
termina ese registro. El comando beginShape( ) requiere un parametro para decirle qué tipo
de forma para crear desde los vértices otorgados. Los parametros disponibles

para beginShape( ) son LINES, LINE_STRIP, LINE_LOOP, TRIANGLES, TRIANGLE_STRIP,
QUADS, QUAD_STRIP, y POLYGON.

Luego de dar el comando beginShape( ), una serie de comandos vertex( ) (vértices) deben
seguir. Para dejar de dibujar la forma, usa el comando endShape( ). Los comandos vertex
() con dos parametros especifican la posicion 2D y los comandos vertex( ) con tres
parametros especifican la posicién en 3D. Cada forma sera delineada con su correspondiente
color de trazo y llenada con el color de llenado (ver la seccién de Color para mas informacion.

Aqui hay algunos ejemplos de Processing.org

beginShape(LINE_LOOP);
vertex(30, 20);
vertex(85, 20);
vertex(85, 75);
vertex(30, 75);
endShape( );
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beginShape(TRIANGLES);

vertex(30,
vertex(40,
vertex(50,
vertex(60,
vertex(70,
vertex(80,

75);
20);
75);
20);
75);
20);

vertex(90, 75);
endShape( );

beginShape(TRIANGLE_STRIP);
vertex(30, 75);

vertex(40,
vertex(50,
vertex(60,
vertex(70,
vertex(80,

20);
75);
20);
75);
20);

vertex(90, 75);
endShape( );

noFill( );
beginShape(TRIANGLE_STRIP);
vertex(30, 75);

vertex(40,
vertex (50,
vertex(60,
vertex(70,
vertex(80,
vertex(90,

20);
75);
20);
75);
20);
75);

endShape( );

noStroke( );
fill(153, 153, 153);
beginShape(TRIANGLE_STRIP);
vertex(30, 75);
vertex(40, 20);
vertex(50, 75);
vertex(60, 20);
vertex(70, 75);
vertex(80, 20);
vertex(90, 75);
endShape( );

noStroke( );

fill(102);
beginShape(POLYGON);
vertex(38, 23);
vertex(46, 23);
vertex(46, 31);
vertex(54, 31);
vertex(54, 38);
vertex(61, 38);

vertex(61,
vertex(69,
vertex(69,
vertex(61,
vertex(61,
vertex(54,
vertex(54,
vertex(46,
vertex(46,
vertex(38,

46);
46);
54);
54);
61);
61);
69);
69);
77);
77);

endShape( );
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Tiempo y

movimiento

beginShape(LINE_STRIP);

curveVertex(84, 91); ﬁ
curveVertex(68, 19);

curveVertex(21, 17);

curveVertex(32, 100);

endShape( );

beginShape(LINE_STRIP);
curveVertex(84, 91);
curveVertex(84, 91);
curveVertex(68, 19);
curveVertex(21, 17);
curveVertex(32, 100);
curveVertex(32, 100);
endShape( );

beginShape(LINE_STRIP);
vertex(30, 20);

bezierVertex(80, 0, 80, 75, 30, 75);
endShape();

Para mas detallada informacion acerca de vectores de dibujos, ver los ejemplos Form de
Processing, la referencia de formas de Processing.

Hay mucho mas para dibujar e interpretar en la pantalla, pero yo sélo te he dado las rutinas
de dibujo 2D para asi poder cubrir animacion e interactividad. Luego volveremos a los otros
métodos de dibujo.

En Director hay un marcador. Te asignan una cabeza lectora y métodos tweening para
actores. Cosas como el video, incrustaciones de Flash, QTVRs y sonido parecen animar en su
propio espacio-tiempo. Si trabajas en algo mas que una animacion dinamica puedes utilizar un
fotograma y cédigo en respuesta a un evento ExitFrame o PrepareFrame. En Flash, te dan
una linea de tiempo y un soporte de tweening mas complejo que en Director. Aquellos que
eligen trabajar completamente en ActionScript comunmente usan dos marcos — uno para
ajustar y para llamar un marco de repeticion y otro para repetir para siempre. Actionscript
también te permite responder en cédigo con un onClipEvent (enterFrame). Processing no
tiene linea de tiempo, marcador o métodos de tweening, a menos que decidas estructurar tu
cédigo asi. Como Lingo y Actionscript, Processing te permite responder a un evento de
progresién de fotogramas con tu propia rutina de dibujo. Hasta ahora te he mostrado el
codigo de Processing en Modo Basico, que es para imagenes estaticas. Es un lista de
elementos visuales. Processing tiene tres modos de operacion: basico, estandar y avanzado.
Modo Java es Java convencional, sin las ruedas de entrenamiento. Para comenzar con tiempo
y movimiento iremos a Modo Continuo. Si has estado pinchando los enlaces de este texto,
debes haber visto uno o dos programas en modo estandar Processing. Aqui hay un ejemplo
simple:

int x = 0;

void setup( ){

noStroke( ); En este ejemplo, un rectangulo
by blanco se mueve de izquierda a
void draw( ){ derecha sélo una vez.

background(lQO);_ Un GIF animado muestra este
rect(x, 0, 5, 100); movimiento a la derecha.
X=X+1;

b

Una seccion setup( ) opcional arranca cunado el programa empieza. La seccion de bucle draw
() arranca para siempre hasta que termina el programa. En Lingo setup( ) es similar al
beginSprite o startMovie - y draw( ) es similar a ExitFrame o PrepareFrame. En Flash,
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Ratéon &

teclado

setup( ) es similar al primer marco de animacion que soélo se ejecuta una vez, luego llama al
bucle. setup( ) y draw( ) son ambas funciones. También puedes escribir tus propias
funciones para organizacion y encapsulacion de complejidad . Para mayor informacién sobre

como escribir funciones personalizadas en Java, mira el tutorial de lenguaje de Java -
Implementing Methods section.

Una vez que hayas escrito la primera funcién en Processing, ese programa cambiara
automaticamente al modo estandar. Cualquier declaracion fuera de su funcidon que no sea
variable de inicio no funcionara mas cuando presiones play. Puedes mover este codigo hacia
setup() o draw(). Si quieres que una variable sea global (significando que conserva su valor
fuera del alcance de las funciones) entonces declara la al comienzo del programa, fuera de
ambos draw() y setup(). En el ejemplo arriba, la variable x fue declarada global.

En Processing, la funciéon de framerate(n) se puede utilizar para retrasar o para acelerar el
bosquejo entero, pero es ciertamente posible mover cosas en diferentes velocidades

simplemente variando la cantidad que incrementas, o usando floats y solamente agregando

una fraccion a ellos. Para un control més a largo plazo y a tiempo mas exacto, Processing da
el acceso completo a la medidas occidental de tiempo.

year( ) // afio actual, p.ej. 2002, 2003, etc.
month( ) // mes actual, de 1..12

day( ) // dia del mes, de 1..31

hour() // hora actual, de 0..23

minute( ) // minuto actual, de 0..59
second( ) // segundo actual, de 0..59

Una funcion especial llamada millis( ) devuelve el niumero de milisegundos (miles de un
segundo) desde comenzar el applet. Esto es comUunmente usado para secuencias animadas
temporizadas.

millis( ) // nGmero de milisegundos desde el comienzo del applet.

También es posible hacer que tu applet espere al usar la funcién e demora (delay). Usar esta
funcion puede ajustar efectivamente los tempos (frame rates).

delay(40); // hace una siesta de 40 milisegundos
void draw( ){

print(month( )+"/"); Aqui hay un ejemplo
print(day( )+"/"); en el que el tiempo
print(year( )+""); actual y la fecha son
print(hour( )+":"); constantemente
print(minute( )+":"); escritas a Ja
printin(second( )); siguiente area al

T final de la ventana

de Processing.

Esto no es un ejemplo muy bonito pero es facil de entender. Para ejemplos de tiempo mas
bonitos (y complejos) mira Milliseconds, de REAS. Para mas ejemplos de movimiento

animado, véase los ejemplos Motion de Processing.

El acceso al raton y el teclado son similares al modo que lo hacen Flash y Director . En Lingo,
el raton es direccionable con the mouselLoc, the mouseH, y the mouseV. Ademas hay
también manejadores de suceso de ratbn como on mouseDown. En Flash, hay onClipEvent
(mouseDown), etc. En Processing, la funcién mousePressed( ) se llama cada vez que el
ratén es presionado y el método mouseReleased( ) es llamado cada vez que el ratén es
liberado o dejado de presionar. Lo que debes hacer es agregar la funciéon a tu cédigo, asi
como en draw( ).
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void draw( ) {

background(190);
rect(mouseX-5, mouseY-5, 10,
10); En este sencillo ejemplo,
3 un cuadrado es dibujado
or donde el ratén vaya.
void mousePressed( ) { P 4 %
fill(0); Si aprietas el raton el
¥ cuadrado se tornara
void mouseReleased( ) { negro.

fill(255);
e

Para mas informaciéon de ratdon, mira la referencia del raton de Processing, y no te olvides de
revisar estos ejemplos Mouse de Processing.

La entrada del teclado es igual a Flash y Director.

void draw( ) {

if(keyPressed) { En este simple ejemplo
fill(102, 0, 0); el cuadrado cambia a
Yelse { rojo oscuro si cualquier
fill(204, 102, 0); tecla esta siendo
b presionada. No hay
rect(30, 20, 55, 55); necesidad de redibujar
¥ de fondo!

La entrada del teclado también puede ser distribuida como un event handling function.

int x = 50;
inty = 50;
void draw( ){
background(190);
rect(x,y,10,10); En este ejemplo, las
3} teclas del teclado
) moveran el cuadrado
void keyPressed( ){ alrededor. L]
if(key=="w'| |key=="W"){
y--; "
}else if(key=="'s'| | key=="S"){
y++] E (%) d
Yelse if(key=="a’| |key=="A"){ =
X-=;
}else if(key=="'d'| | key=="D"){
X++;

3
¥

Para mayor informacién de entrada de teclado, mira la referencia del teclado de Processing, y
no olvides de revisar estos ejemplos Keyboard de Processing.
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Presentacion /

Exportar

Dibujar
archivos de
imagen

@ En Flash y Director, hay controles en las teclas e funciones
en el menud que pueden seleccionarse para arrancar tu
programa, de un modo que usa toda la pantalla y cubre todo los
ornamentos presentes en un sistema operativo. La modalidad de
pantalla completa es muy 0til para la instalacion y presentacion.
En Processing, puedes escoger en el menu Sketch > Present, o
puedes apretar Ctrl+P (3£+P en un Mac). Ademas intenta apretar
el boton de play mientras presionas SHIFT. La pantalla completa
ira a gris oscuro y veras tu creacion en el medio. Para volver a los
normal, presionas ESC. Si no funciona hay un botén de “detener”
a la esquina final izquierda.

a Cualquier programa de Processing puede ser publicado como un applet de Java. Primero
aseguUrate que el bosquejo (sketch) esta salvado, luego escoge File -> Export, o
presiona Ctrl+E (o presiona el botdn de exportar). Veras el area de mensajes de Processing
diciendo "Exporting. . ." por un momento y luego dira "Done Exporting." Para tener los
archivos de la web, entra a la carpeta de bosquejos de Processing. Busca la carpeta con el
nombre de tu bosquejo y abrela. En esa carpeta veras otra llamada applet. Esta carpeta
puede ser subida a la web. Recomiendo altamente editar el index.html predeterminado que
se genera desde Processing. Debes mantener todos los archivos relativos al HTML en esta
carpeta applet, ya que estan relacionadas de un modo que ninguna otro medio HTML est&a
relacionado.

sketches/
your_sketch_name/
applet/
your_sketch_name.java
your_sketch_name.class
your_sketch_name.jar
index.html

save( ) and saveFrame()

Si necesitas exportar formatos no-interactivos, es posible hacer archivos .tif de la ventana de
Processing usando la funcion saveFrame( ) (guardar fotograma). Ubicando este método al
final del bucle draw( ) guardaréa la imagen en la pantalla. Si saveFrame( ) es llamado
numerosas veces, creard una secuencia de imagenes como la siguiente: screen-0001, screen-
0002, screen-0003, etc. Usando save( ) (guardar) te permitira elegir un nombre de archivo.
Es simple importar estas imagenes al Quicktime y otro programa de video para hacer una
documentacién animada de un programa de Processing. Aunque Processing tiene incorporado
esta facil funcidon de guardar imagenes, también es posible exportar otros formatos con un
poco mas de trabajo. Por ejemplo, aqui hay un programa de Processing que exporta a Adobe
lllustrator.

Poner una imagen dentro de un bosquejo de Processing es simple. Processing acepta .gif, .
jpg, .tga, y .png (a menos que quieras hacer trabajo extra). Puedes poner la imagen dentro
de tu bosquejo usando el sistema de archivos y un par de lineas de cédigo. Primero guarda el
bosquejo. Luego puedes encontrar el archivo del bosquejo chequeando en la carpeta de
bosquejos definida en las preferencias (File -> Preferences). Alli encontraras una carpeta
llamada sketches (libro de bosquejos). Alli probablemente encontraras la carpeta con el
mismo nombre que tu bosquejo. Dentro encontraras otra carpeta llamada data. Aqui es la
carpeta donde debes ubicar tu archivo de imagen para un Processing mas facil. Aqui , otra
manera de decirlo:

sketches/
your_sketch_name/
data/
your_imagefile.gif

Asumamos que tengo un bosquejo llamado image_example_1 y quiero dibujar la siguiente
imagen llamada twombly.jpg, un dibujo de Cy Twombly:
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Lo guardaré en una carpeta apropiada:
Sketchbook location/sketches/
image_example_1/
data/
twombly.jpg

Y sé que estoy listo para agregar el codigo.

size(150,150);
Plmage b = loadlmage("twombly.jpg");
image(b,0,0,150,150);

PImage es un objeto que mantendré tu archivo cargado hasta que lo dibujes. b es el nombre
que escoji. image( ) es lo que dibuja la imagen a la pantalla.

image(PImage, x, y, width, height);

También puedes elegir el omitir el ancho y alto y la imagen se dibujara a escala normal.
Importar archivos no son el Gnico camino, también funcionan los URLs.

Para mayor informacién de imagenes, consulta el manual de Processing. Aqui esta la parte
explicando cargando y mostrando imagenes. Construir a través de este conocimiento, también

es posible mostrar images sequenciales (video footage). Para mas informacion mira los
ejemplos Image de Processing.

http://www.jtnimoy.net/itp/p5/workshop/index_espanol.html (14 of 18) [8/28/2007 9:05:01 AM]


http://processing.org/reference/loadImage_.html
http://www.processing.org/learning/examples/sequential.html
http://processing.org/learning/index.html

Tutorial de Processing para mentes Macromedia

3D

Formas

+i

[0.0]

+

vertex(x, vy, z);
line(x1, y1, z1, x2, y2, z2);
bezierVertex(x, v, z);
curveVertex(x, vy, 2);

box(size);
box(width, height, depth);
sphere(size);

size(100,100,P3D);
translate(58, 48, 0);
rotateY(0.5);
box(40);

size(100,100,P3D);
noFill( );
translate(58, 48, 0);
rotateY(0.5);
box(40);

size(100,100,P3D);
lights();
translate(58, 48, 0);
rotateY(0.5);
box(40);

Ha habido mucha preocupaciéon y quejas por introducir 3D a
entornos de 2D. En Flash, muchas herramientas de terceras
partes han sido desarrolladas. En Director, un actor grafico de
3D vectorial se introdujo recientemente. El sistema es tan
complejo que muchos han desistido incluso de aprenderlo.

En Processing, 3D s6lo significa definir un rendering 3D y
agregar una eje z.

Processing actualmente tiene tres modos de rendering. Si no especificamos ningin modo en
la funcién size() - como hecho en todos los ejemplos hasta ahora - usamos el el rendering de
Java 2D. Para usar funciones de 3D hace falta especificar el rendering de la siguiente manera:

size(100,100,P3D); //P3D define el modo de rendering para 3D

Este modo también da soporte a todas las funciones de 2D y ademas supone ser mas rapida
que el rendering 2D. Ademas existe otro modo de rendering llamado OpenGL. Mas informacion
sobre el los modos de rendering encuentras en esta pagina de Processing.
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Pixeles

size(100,100,P3D);

noStroke( );

lights();

translate(58, 48, 0);

rotateY(0.5); k

box(40);

size(100,100,P3D);
noStroke( );
lights();
translate(58, 48, 0);
sphere(28);

Notese que box (caja) y sphere (esfera) no te piden que especifiques coordenadas. En estos
ejemplos, es necesario usar translate y rotate. También hay scale, y un par de funciones
llamadas push y pop que te permiten marcar tus traslados en una moda muy organizada.
Para mayor informacioén ver la referencia de transformaciones de Processing y

los ejemplos Transform de Processing. Si no te importan estas transformaciones, siempre
hay una solucién.

Notese el uso de lights( ) y noLights( ). Usar luces renderizaran la forma 3D de un modo
que sugerira sombreado. Para mas informacion, mira la referencia de luzes de Processing.

";Qué? ;Esto es para 3D?"

Si crees que esto no es suficiente 3D para permitirte hacer cosas interesantes, entonces mira
las cosas que han hecho en la exposicion de Processing. Y esto es s6lo el comienzo.

El control sobre los pixeles esta actualmente lejos de Flash .SetPixel y GetPixel recién han
sido afadidos a Flash y Director (y un conocido artista interactivo, amante de Director ha
adoptado el apodo de SetPixel). Estudiantes del ITP van a un curso dictado por Danny Rozin
llamado El Mundo — Pixel por Pixel,(The World - Pixel by Pixel), y continGan programando en C
porque es la Unica manera suficientemente rapida para alcanzar las metas conceptuales
(Siendo Actionscript, Lingo y MAX las Unicas alternativas). Es comUn entre estos estudiantes
de ITP prepararse para el curso de Danny's yendo a un curso C. Trabajar en pixeles de
Processing es considerablemente mas rapido que en Lingo, y mucho menos complejo. Aunque
Java no se compara a la velocidad de C, pronto los estudiantes de Danny podran explorar la
posibilidad usando Processing para acelerar la curva de aprendizaje.

get(x, y); // Returns an integer
set(x, vy, color);
pixels[index]; // Array containing the display window

int width = 100;

int height = 100;

PImage b; // declare variable "b" of type PImage
b = loadlmage("basel.gif");

image(b, 0, 0);
for (int i=30; i<(width-15); i++) {
for(int j=20; j<(height-25); j++) {
color here = get(30, j);
set(i, j, here);

3

}

Controlando los pixeles, también puedes implementar tus propias rutinas de dibujo. Por
ejemplo, aqui hay transparencia. Escribir el resto de las tintas (inks) de Director no sera duro.

Aqui hay una funcién de linea de puntos (dotted line).

Para mas informaciéon de pixeles mira la Preferencia de imagenes de Processing y los ejemplos

Image de Processing.
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Tipografia

El sistema de renderizado de tipografia usa un formato de archivo de caréacter especifico de
Processing. Los creadores del software han incluido un tipo de funcidon de importacion de tipo
de letra en el menu para ayudarte, y ademas han dotado al programador de Processing con
una gama de tipos de letra para escoger. Pincha aqui para ver los tipos actuales. Estas
fuentes estan almacenadas como imagenes bitmap. Aqui hay un ejemplo muy sencillo de
renderizar texto al bosquejo. Arranca este programa y espera equivocarte.

acfont_example = I | I il

size(200,100);

background(#FFFFFF);

fill(#000000);

PFont f = loadFont(*'Bodoni-Italic.viw™);

textFont(f, 50); handglove

text(""handglove’, 14, 60);

Os saldra un error diciendo que no puede encontrar Bodoni-Italic.vlw. Esto es porque no
has importando aun la fuente a tu carpeta de data. (la seccién de imagen de este manual
tiene mas informacion de la carpeta de data). Usa la funcién de creacion de fuentes del menu
Tools -> Create Font... para copiar fisicamente el archivo de fuentes a tu carpeta data.
Ahora el programa arrancara bien luego de haber hecho eso.

PFont f = loadFont( "Bodoni-Italic.vlw" ); carga esa fuente dentro de la variable f.
textFont(f, size); determina la fuente actual y su tamarfio antes de dibujar el texto.
text("handglove", x, y); renderiza el texto en el lugar.

Este ejemplo incorpora rotacién, y un simple bucle for.

size(200,100);
noStroke( ); =0 x|
PFont f = loadFont("Univers66.viw");

textFont(f, 50); .
fill(#FFFFFF); d z z
ellipse(-50,-55,150,150); y
fill (#CC6600); ‘E:e
for(int i=0;i<20;i++){ y
rotateZ(0.2); e
text("dizzy", 90,0); cva e‘

by - -

Si no te interesa esto porque no te va el rollo de tipografia hay un modo mas simplificado. Si
necesitas algo como un campo de entrada de texto es Gtil que escribas tu propio. Muchos
widgets de usuarios de interfaces no son dificiles de agregar al proyecto si piensas de ellos
como ejercicios pequefios, modulares e interactivos mas que algo que el sistema operativo
proveera exclusivamente. Lo que ganas es el control Gltimo sobre el disefio. Para mas
reinvenciones de interfases vernaculares mira los ejemplos GUI de Processing.

Mira los fantasticos ejemplos Typography de Processing. Processing viene de un grupo de

gente preocupada por la estética y la computacion. Nuevas formas de tipografia es una de las
cosas que por las que este MIT Media Lab research group es famoso.
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El futuro

Processing es un trabajo muy nuevo y continuo sujeto a constantes actualizaciones. Una
nueva entrega puede ser facilmente instalada en el lugar de la vieja y puedes mantener tu
carpeta de sketches ajustando las preferencias de Processing. Al traducir este documento,
Processing esta en su version BETA 0115. Processing en sus inicios se llamo Proce55ing asi
que no te sorprendas si encuentras documentos bajo este nombre. Desde la version 0085
Processing esta en estado BETA. Todavia tiene errores por corregir y asuntos pendientes antes
que salga la versiéon 1.0, hasta entonces van a mantener este sistema de nombramiento con

los cuatro digitos.

A diferencia con Flash y Director, que estan escritos mayormente en C, Processing fue escrito
en Java, el mismo lenguaje en el que se le pide a los usuarios que programen. Gracias a la
popularidad de Java podemos reutilizar facilmente programas en este lenguaje. Hay muchas_
librerias especialmente adaptadas, algunas de ellas estan incorporadas en Processing: Video
para reproducir Quicktimes y incorporar camaras web, Serial para comunicarse con
dispositivos conectadas al puerto serial, Net para mandar y recibir datos por Internet usando
clientes y servidores, ademas de las librarias OpenGL, PDF, DXF y JavaScript. Ademas hay
librerias como Sonia para crear sonidos, proMidi para mandar y recibir datos midi y muchos
otros para comunicarte con servicios web como Google, del.icio.us, flickr entre otros.

Con todo esto en mente, espero encuentren que Processing es Util en suma a las herramientas
de Macromedia que estas aprendiendo. Por favor, publica cualquier ejemplo de Processing
para que podamos aprender de tu exploraciéon y no te olvides de ser parte de la comunidad

online. jFeliz creacion!
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Computation Group,
liderado por John Maeda,
donde trabajo con Ben Fry y
Casey Reas.

website

Ben Fry se doctord en el
Aesthetics and Computation
Group en el MIT Media
Laboratory donde investigd
métodos de visualizacion de
grandes cantidades de datos
dinamicos. Su trabajo actual
esta dividido entre consultas
y la visualizacion de datos
genéticos para Eric Lander
en el Eli & Edyth Broad
Institute de MIT & Harvard.
website

Casey Reas se gradud en
Media Arts and Sciences en
el MIT Media Laboratory
donde fue miembro del
Aestetics and Computation
Group de John Maeda.
Después fue profesor
fundador del Interaction
Design Institute lvrea en
Italia. Actualmente ejerce
como profesor asistente en
el departamento de Design
& Media Arts en UCLA. En
sus clases procura entregar
bases para la reflexion de
ordenadores e internet,
como un medio de
exploracion y definir una
estructura para crear una
sintesis avanzada de cultura,
tecnologia y estética.
website
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